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From 
CONVERSATIONS ... TO ACTIONS

CONTENTS:
A do-it-yourself process that gradually ramps up 
community engagement through several phases:

WHY DO WE NEED 
THE COOLKIT:
Many community members are aware of the urgent need 
to make changes in their neighbourhoods to improve 
sustainability and quality of life. Whether you’re interested 
in increasing access to green space, enhancing the aesthetics 
of your street, or being more resilient to climate change, this 
guide will help bridge your individual ideas to neighbourhood-
wide action.

WHO IS THIS FOR?
• Community members wanting to have mean-
ingful interaction with their neighbours  in 
caring for the places where they live

•  High school and other students needing to have 
structured engagement in their communities

• Practitioners looking to apply their expertise to 
important local causes

MAP YOUR COMMUNITY
Get to know your block and see it in a new way

START A CONVERSATION
Meet your neighbours, test your knowledge

RATE YOUR BLOCK
Rate the climate friendliness of your block, 
and compare with your neighbours

ACTION ON THE GROUND
Identify priorities, implement strategies

VISIONING YOUR FUTURE
What might your block look like without the 
street trees?
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GRADUALLY RAMP UP ENGAGEMENT
SCOPE:
Here is a list of all of the tools and activities that we introduce in this toolkit, organized into 5 steps. A series of hands-on activities 
are designed to help you see your neighbourhood in a new way, make climate change visible, and re-imagine your future.

MAP YOUR COMMUNITY

START A CONVERSATION

• Urban forest quest
• Climate change detective
• Map with Google Earth
• Map with i-Tree

• Block scorecard

• Low carbon future
• High carbon future

• Story collection
• Photo gallery
• Photo quiz
• Non-trivia quiz
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i TOOLKIT AT A GLANCE
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ACTING

VISIONING

VISION YOUR FUTURE

ACT ON THE GROUND
• Make a pledge
• Plan ahead
• Protect your trees
• Beautify your yard/block 32



CLIMATE CHANGE IS HAPPENING 

45%

RISING SEA LEVEL
Estimated increase of sea level 
in coastal B.C. by 2100 80 cm 
or more7. We will lose homes, 
communities, and ecosystems (an 
estimated total damage $2.1-7.6 
billion by 2050)7

MORE FLOODS 
& DROUGHTS
Warmer weather and changing 
precipitation (e.g. rain and snow) 
will cause more severe and 
frequent floods and droughts6.

 SPACE HEATING
AND COOLING

CARS AND TRUCKS
AIR TRAVEL

WATER HEATING

BUS AND RAIL

 APPLIANCES AND
LIGHTNING

WASTES

MELTING SNOWPACK
Snowpack in B.C. has been 
reduced by HALF over the past 
50-100 years6

MORE HEAT WAVES
BC has warmed up by about 1 °C over the past 
century; further warming of 2 °C by 20504. 
The heat wave in 2009 killed 100 people in 
Vancouver5

17%

8%
13%

2%14%

1%

British Columbia has committed to 
reduce carbon emission by8:

33% below 2007 levels by 2020

80% below 2007 levels by 2050

WHY BOTHER ABOUT CLIMATE CHANGE?i

Most scientist agree that the main CAUSE of climate change is the carbon emission from human activities (e.g. 
driving cars, energy use), which traps heats and warms up the earth's surface. They also suggest to keep global 
warming well below 2 °C (relative to preindustrial levels)1. 

What will happen if the global temperature rises by 2 °C? 
All projected impacts (see below for examples) would increase in intensity by 1/3. For example. droughts would be 1/3 longer, 
storm would be 1/3 stronger.2                                                                                   Want to learn more? Check NASA: http://climate.nasa.gov

 Households in B.C. directly account for 30% of the total greenhouse gas (GHG) emissions3. The share of emissions
   are shown in the grey clouds3
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HOW CAN URBAN FORESTS HELP?

URBAN FOREST IN VANCOUVER TODAY
Is made up of 9

  140,000 street trees
  300,000 park trees
  and an unknown number of private trees

18% of Vancouver is covered by tree canopy, as calculated and mapped by he City10

  11% of canopy on streets
  27% of canopy in parks
  62% of canopy on private property

Tree canopy cover is the ground area covered by tree leaf 
canopies as seen from the air9

Infrograph by Sara Barron

`
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Map by City of Vancouver

What is A Urban Forest?
Urban forest is comprised of a variety of vegetation and landscape types such as public parks, streetscapes, natural areas and 
yards, which together form a complex system of urban greenery. Urban forest will be vital in a hotter future for keeping the 
elderly and infirm alive during heatwaves, and reducing air conditioning costs.    
To learn more, please check: http://forestry.sites.olt.ubc.ca/files/2015/06/CFSreport_Final_Table5Edits_20150605-v7.pdf



HOWEVER , WE ARE LOSING HEALTHY TREES 
EVERYDAY, MOSTLY ON PRIVATE PROPERTIES

To protect our urban forest and better prepare for future 
climate changes, Vancouver promises to increase tree canopy 
from 18% to 22% by 2055, through better management and 
replanting 150,000 trees by 202010.

"Over the last two decades, 23,490 healthy, mature trees were removed on private properties (including residential, 
institutional, commercial and industrial land). In 2013...about 5 healthy, mature trees were removed everyday."

 - City of Vancouver

WHAT CAN WE DO?
BC's carbon reduction target and tree planting target is for all of us, we must do our share of keeping to 2 degrees 
warming. That means all of us must work together to cut our emissions by taking better care of trees in our 
neighbourhood, switching to renewable energy, reducing our driving or switching to hybrids or EVs, and many 
other ways...

This Coolkit is to help you climate-proof your neighbourhood while improving the urban forests that surround your 
home.

How much canopy cover does 
your neighbourhood have?

What can you do to help increase 
your neighourhood's tree canopy?
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BLOCK PARTY INFORMAL GATHERING

STEP 1: START A CONVERSATION

Now you know how much climate change and urban forests matter to us. It is time to share 
your knowledge with your family, friends, and neighbours. Here we provide some activities 
to help you start a conversation with others on climate change and urban forests.

1. COLLECTING STORIES about changes that have happened on your block in the past

2. PHOTO GALLERY to discuss changes on your block

3. PHOTO QUIZ to look for CIMA of climate change on your block

4. NON-TRIVIA QUIZ to test your knowledge on urban forests and climate change

Most of the activities here are very suitable and fun to do with your family, friends and neighbours through a block 
parties or informal social gatherings.

A good place to start the conversation and hold 
introductory games or exercises with your neighbours.

Over coffee, wine, or supper at your or your neighbour's 
place, or a pub/coffee house nearby, to discuss further 
activities. 
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Collect stories of the changes that happened on your block: 
More trees or less trees? More houses or less houses? More cars or less cars?                                            1-2 hours

Grab a pen and a notebook, spend a cozy afternoon with your grandparents or your neighbour(s) who have lived in 

this area for a while. Record what you hear and what you see.                                              

STORY #1  _____________________________________________________________________________________________

                        _____________________________________________________________________________________________

STORY #2  _____________________________________________________________________________________________

                        _____________________________________________________________________________________________

START A CONVERSATION
STORY COLLECTION

By Rhoda Baer
http://res.freestockphotos.biz/pictures/17/17068-a-woman-and-older-man-sitting-at-a-table-pv.jpg

Do you know what changes have happened to your block in the past decade?
Have you spent quality time with your grandparents or parents recently?   
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START A CONVERSATION
STORY COLLECTION

START A CONVERSATION
PHOTO GALLERY 

PHOTO GALLERY ASSIGNMENT
Each group member takes a picture of:

1.	 Your favourite tree on your block

2.	 A place where there used to be a tree 

3.	 A place on your block where you like to go 
for walks or where you would like more trees

4.	 Something on the block that you connect 
with climate change

HOW TO MAKE A 
FACEBOOK PAGE 
FOR MY BLOCK:

Log on to Facebook. At the top-right corner 
of your personal Facebook page, there is 
a little upside-down triangle- click on this 
and select "Create Page" and then "Cause or 
Community". Follow the setup process from 
there. The creator of the page is automatically 
the administrator but this can be adjusted:  go 
to the page (it is now searchable in the search 
window at the top of the screen), click Settings, 
go down to Page Roles, and add your group 
members.

OPTION 1: A photo gallery
        1-1.5 hours

Choose a room or public location (such as a wall in 
a community centre or an accessible bulletin board) 
where your team can gather for future toolkit exercises. 
If easier- your group can simply keep a scrapbook or 
3-ring binder of the photos. Portable and easy to store!

Post your photos for all to see, and each person describes 
them briefly. What do you all notice?

OPTION 2: An online album 
       1-3 hours, depend on how many photos and how often you 

update

There are several options for making free online photo 
albums.

Flickr: www.flickr.com is a site for posting photos 
publicly or only for a group of specific people. It requires 
a Yahoo email account (free) and a password, both of 
which would be shared amongst your group.

Facebook: www.facebook.com allows your to create a 
simple web page that your group can use and upload 
photos to.

8
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YOUR NAME:  ________________                                                                                    30 minutes

START A CONVERSATION
photo quiz

PHOTO #1

PHOTO #2

PHOTO #3

PHOTO #4

PHOTO #5

INSERT SAMPLE 
PHOTOS HERE

This is a climate change visual literacy test. Here we are looking for 
“CIMA”. For each photo, write down which of the following you see: 

    Causes: Aspects of living that produce high carbon emissions

    Impacts: Visible climate change impacts or vulnerability to future impacts

    Mitigation: Climate solutions that foster low carbon living

    Adaptation: Climate solutions that foster resilience to climate impacts

You can use the photos in PHOTO GALLERY for this activity

Causes: things related to high carbon emissions

Impacts: consequences of climate change and vulnerabilities

Mitigation: things related to low carbon emissions

Adaptation: ways to deal with the impacts of climate change
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START A CONVERSATION
photo quiz

START A CONVERSATION
NON-TRIVIA QUIZ 

QUESTION #1

QUESTION #2

QUESTION #3

QUESTION #4

QUESTION #5

QUESTION #6

These are sample questions to be answered by participants 
on the the Answer Sheet (pg 6). They are just examples- feel 
free to come up with your own that best match the interests 
and issues in your own community.

QUESTION SHEET

YOUR NAME:  ____________                                                                                                   30 minutes

What is B.C.’s 2050 carbon emissions reduction target 
by 2050?

what produces the most carbon emissions from 
households in B.C.?

What is the average carbon footprint of residents in 
B.C.?

How many trees is Vancouver planning to plant from 
2010 to 2020?

What kind of tree provides the biggest canopy on your 
street? 

Are there any trees on your street that are native to your 
region, for example, coastal B.C.?
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START A CONVERSATION
NON-TRIVIA QUIZ 

ANSWER #1

ANSWER #2

ANSWER #3

ANSWER #4

ANSWER #5

ANSWER #6

Write down short answers to Questions from page 5. 
Once complete, discuss the answers with the group.

ANSWER SHEET

YOUR NAME:  _____________                                                                                                   30 minutes

11



START A CONVERSATION
NON-TRIVIA QUIZ 

13

STEP 2: MAP YOUR BLOCK

Do you know much about trees on your block or in your yard? It is time to create an 
inventory of important things on your block and think about their links with climate 
change. In this section, you will learn to see your surroundings in a new way, and learn to 
use some state-of-the-art mapping techniques.

1.	 YOUR URBAN FOREST QUEST to look for squirrel habitats (i.e. trees and canopy) on  your 
block

2.	 CLIMATE CHANGE DETECTIVE QUEST to investigate car habitats and other signs of climate 
change

3.	 MAP DIFFERENT HABITATS on your block 



MAP YOUR BLOCK
URBAN FOREST QUEST

  
___

# of trees on north side:	

# of trees on south side:

# of the biggest tree:

# of gaps:

Species name:

Yes or No?

Girth of the biggest tree 
in cm:

DO YOU KNOW...
How much squirrel habitats is on your block? 
How many trees are there on your block?
Why trees are important to us and squirrels?

Try this quest
WITH YOUR kids 
or neighbours!

1.1. How many street trees are on your block?                              
Street trees are those in the public right-of-way alongside the curb

First, walk down the sidewalk on the north side of the street and count the 
street trees (number them from first tree at west end of the block).

Note the number of the tree (from the start point in Question 1.1)
Use the "hugmeter" (yourselves) to find the biggest tree.

Can a squirrel make it from one end of the block to the other, and cross the 
street at least twice, without coming down to the ground? 

Walk along the sidewalk and look at the tree canopy. Assume a squirrel can 
leap about 2 metres (6 feet or the length of a person) between branches. 
Squirrels can also use trees in gardens.

Bonus question: Measure the circumference (girth) of the biggest tree 
trunk you can find. Measure round the tree at breast height, about 1.3 metres 
high (4.5 feet), using a tape measure provided

If “No”, how many gaps (greater than 2 metres) did you spot where a squirrel 
would have to come down to the ground?

Bonus question: Can you name the type of tree?

1.2. Which is the biggest tree trunk on your block? 

1.3. Play the Leaping Squirrel game:

Then come back along the other (south) side (continue numbering them 
to the last tree on the west end of the block).

YOUR NAME/
YOUR TEAM NAME                                                                                                       

_____________________________________
_____________________________________      You will need 30 minutes

answersQUESTS
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MAP YOUR BLOCK
URBAN FOREST QUEST

1.	 Are there enough trees on the block?

2.	 How old do you think that big tree is?  How much longer do you think it will live?

3.	 Why is safe squirrel habitat (tree canopy) important to us, not just squirrels?  What 
do large trees give us?

4.	 What would it look like if all the trees were gone?

5.	 How can these trees survive droughts like the one we had in 2015?  Do they need 
our help?

6.	 What else do we need to do to keep a healthy urban forest?

WHAT DID YOU LEARN ABOUT THE URBAN FOREST ON YOUR BLOCK?

CONGRATULATIONS!
 
You have completed your urban forest quest.  Share completed form with others and see 
how you did.

14
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MAP YOUR BLOCK
CLIMATE CHANGE DETECTIVE QUEST

# of vehicles:

% of total (approx.):

# of gardens:

% of total (approx.):

% of total (approx.)

# of buildings:

# of food gardens

DO YOU KNOW...
How many cars are parked on your block?  
How many food gardens on your block?
Whether your roof is suitable for solar panels?

Try this quest
will help you find 
out the answers!

1.1. How many cars can you count on the block? 

How many of them are carshares, hybrid vehicles (oartly electric), electric 
vehicles (EVs).

Count the total number of gardens

Count the number of building with solar panels (photovoltaic or solar hot 
water) on the north side of street only.

Count the number of gardens growing food

What do most of the buildings use for energy sources?

1.3. How many homes are using solar energy?

Why does that matter?
Hint: ground transportation accounts for 47% of household emissions in B.C.
To read more: http://www.davidsuzuki.org/issues/climate-change/science/climate-solutions/
transportation-solutions/

Count the number of buildings with roofs suitable for solar energy (north 
side of street only). Large open areas of south-facing or flat roofs, at least 2x2 
meters, & unshaded by trees or other buildings. 

1.2. How many gardens have food being grown?                              
e.g. vegetables, herbs, fruits

How does local food help climate change?
Hint: carbon emissions come from meat production, use of pesticides and 
fertilizers, and transportation of food.
To read more: http://www.davidsuzuki.org/what-you-can-do/food-and-our-planet/food-
and-climate-change/s

# of buildings:

YOUR NAME/
YOUR TEAM NAME                                                                                                       

_____________________________________
_____________________________________      You will need 30 minutes
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MAP YOUR BLOCK
CLIMATE CHANGE DETECTIVE QUEST

1. "Squirrel Habitat" - Trees & Canopy
Now you have an idea of how safe it is for squirrels on your block after the Urban Forest Quest (page 13-14). 
It is time to look at all the trees on your block and figure out how much canopy cover you have.

2. "Car Habitat" - Hard pavement 
You've counted how many cars parked on your street. Do you want to see how much of your block is 
dedicated to cars (either driving or parking)?

3. Any other things you want to map on your block
E.g. grass and soil as worm habitat, south-facing roofs as solar panel potential, and total roof area as pigeon 
habitat. 

See examples below:

“Squirrel Habitat” “Worm Habitat” “Car Habitat” “Pigeon Habitat”

Example (map with Google Earth)
4th Ave. & Cypress Street, Vancouver

map your block
HABITAT mapPING (grey-green analysis)
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1. MAP with markers                                                                                      
You will need: 

•	         30 minutes
•	 Several colourful markers
•	 A couple of photos of your block/yard to map on  

You can print them on regular paper instead of photo paper. Recommended size: 11" by 17" or 18" by 24".

There are many ways to map things on your block. Here are three practical ways:

1.	 with markers (easiest and quickest) - Page 17

2.	 with Google Earth (simple mapping and visualization) - Page 18

3.	 with i-Tree Canopy (simple but more complete measurement of different land covers and benefits of 
trees) - Page 20

(squirrel habitat;
mitigation/adaptation)

(car habitat; cause of climate change)

(car habitat;
cause of climate change)

(squirrel habitat; 
mitigation/adaptation)

Could you also map some signs of climate 
change too? Hint: see CIMA below

How are the habitats related to climate 
change? Which are causes and which are 
impacts? And are any influenced by climate 
change?

What is CIMA?
Causes: things related to high carbon emissions

Impacts: consequences of climate change and vulnerabilities

Mitigation: things related to low carbon emissions

Adaptation: ways to deal with the impacts of climate change

MAP YOUR BLOCK
HOW TO MAP
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MAP YOUR BLOCK
HOW TO MAP

You will need:                                                                            
•	        1-2 hours
•	 A computer connected to the Internet

Creating polygons (habitats)
Here we use canopy mapping (squirrel habitats) as an example:

1.	 Download Google Earth Pro (free) on your computer first. You can download it here: http://www.google.com/
earth/download/gep/agree.html.

2.	 Type your address in the search bar on the left panel of Google Earth to find your place.

3.	 Menu bar:   

4.	 Use the  button, add a polygon. Trace around the border of the canopy that you would like to mark. Left-click 
adds a new vertex (point), right-click removes the last vertex that you added. Click    to finish tracking.

5.	 Continue adding polygons for each area pf canopy. You will see them show up in your Places menu on the left 
.panel. Map all trees or tree clumps on your property, and give each tree/canopy a unique name as you like.

Want to learn more? Please 
go here: 
https://www.google.com/ea
rth/learn/ 

MAP YOUR BLOCK
MAP with google earth
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Calculating the area of a polygon
1.	 Once you have created a polygon, right-click it in the Places menu (on the left of the screen). Select Get Info 

and a Google Earth – Edit Polygon window opens up. You can see the measurements of the polygon’s area and 
perimeter by looking under the button                                                                                                             

 You can also change polygon styles (e.g. colour, transparency) in the Properties window under Style, Color tab (see 
picture in the previous page).

2.	 Measure the area covered by trees at your place, divide them by the total area of your place: 

You will get a percentage of areas covered by tree canopies, which is the tree canopy cover. 
You can also measure the tree canopy cover at your block, and compare with the city’s average (18%).

DON'T FORGET TO SAVE YOUR WORK: click File> Save> Save my places, and all of the polygons will be saved to the 
My Places section of the Places menu.

RESULTS
        _________% of your block & _________% of your yard is squirrel habitat (tree canopy)

         _________% of your block & _________% of your yard is car habitat (hard paving)

         _________% of your block & _________% of your yard is ___________ habitat

         _________% of your block & _________% of your yard is ___________ habitat

         _________% of your block & _________% of your yard is ___________ habitat

Think about your results a bit more...
Which habitat has the highest %? Which has the lowest?
18% of Vancouver is covered by tree canopy. How about your block?
Are there any findings that surprise you?
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You will need:                                                                            
•	        1-1.5 hours

•	 A computer connected with the Internet

What is i-Tree?
i-Tree (http://www.itreetools.org/) is a software developed by U.S. Forest Services to provide urban/rural forestry 
analysis and assessment. Here we will use one of the i-Tree tools, i-Tree Canopy, for this exercise. You will find out the 
coverage % of each habitat and estimated ecosystem services of greenspaces on your block by using this tool.

Measuring landuse type 
cover

Here we use canopy mapping (squirrel habitat) 
again as an example:

1.	 Go to https://www.itreetools.org/canopy/index.php. 
You should see the webpage on the right. 

2.	 Click   when the pop-up appears, 
click  

3.	 When the map appears, zoom to Vancouver and make a 
polygon of your block. Click Finish when you done.

4.	 The website will bring you back to the main i-Tree 
Canopy page. Click  

5.	 A new page will open with your i-Tree classes. The 
default classes are Tree and Non-Tree. Change the 
classes as squirrel habitats, car habitats, worm habitats, 
and pigeon habitats.

Feel free to use these classes or make your own (some 
suggestions are: water, buildings, grass, and soil). 

Be aware that some classes may be difficult to distinguish 
from each other just using the images, so make sure that 
you can tell the classes apart.

step1

step3

step5

MAP YOUR BLOCK
MAP with I-TREE
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6.	 A new page will open asking you questions about how 
to quantify the benefits of your urban forest. Change 
the currency to Canadian dollars (CAD). 

Keep the project location as the U.S.A., as that is the only 
available location unfortunately.

7.	 Now we get to place random points and classify them! 

Under click the  symbol. 

Which one of your classes does this point correspond 
to? Change the Cover Class to the class you want and 
click the          symbol again. Do this at least 100 times 
to get a good representation of points for each class 
(at least 30 for each class). Feel free to do it more than 
100 times if you’re having fun! 

Save your data to make sure that you don’t lose it

8.	 Click  to check some of the ecosystem 
services provided by the trees and greenspace in your 
area, such as pollutant removal, carbon sequestration.

step6

step7

step8

Now you can tell people how important trees are to the city!

Think about your results a bit more...
What was the proportion of all of your classes? 
Was this surprising? 
Is there less green area than you thought? 
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This exercise is to summarise what you have learned from mapping your block, and to 
allow you to rate your block against other blocks (friendly competition). 

Scorecard to see whether your block is prepared for climate change, and how 
green your block is compared to others' blocks

It is very simple, just check the applicable boxes. 

STEP 3: RATE YOUR BLOCK

HOW DO YOU THINK OF YOUR 
BLOCK/YARD?

ENOUGH CANOPY COVER? 

PROPER STORMWATER MANAGEMENT?

EFFICIENT TRANSPORTATION? 



RATE YOUR BLOCK
CAUSES OF CLIMATE CHANGE

a. Multi-story apartment

b. Multiple joined units (duplex, townhouse)

c. Single family home

pointsyour block's carbon footprint

1. What is the most prevalent house type?
3
2
1

a. No cars

b. 1-3 cars

c. 4 or more cars

2. How many cars pass through your block in 20 min?

a. No cars

b. 3-5 cars

c. 6 or more cars

3. How many cars are parked on the street? 

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for causes at the block level              _________

a. <50 m2

b. 50-120 m2

c. >120 m2

pointsyour household's carbon footprint

1. How much heating (winter)/cooling (summer) space per person in your family?
Heating space per person = area that need to be heated / # of people in your household. See more info: http://www.energyexplorer.ca/home-energy/

3
2
1

a. Mostly renewable energy (solar, hydropower etc.)

b. Combination of renewable energy and fossil fuels

c. Mostly fossil fuels

2. How do you heat/cool your home?

a. No cars

b. 3-5 cars

c. 6 or more cars

3. How many cars do you own in your household?

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for causes at the household level    _________

subtotal
add up the points, and write the number on the right as your subtotal score for impacts at the block level            _________



RATE YOUR BLOCK
CAUSES OF CLIMATE CHANGE

subtotal
add up the points, and write the number on the right as your subtotal score for causes at the block level              _________

RATE YOUR BLOCK
impacts OF CLIMATE CHANGE

a. <30%

b. 30%-60%

c. >60%

pointsyour block's vulnerability

1. Extent of impervious (grey) surface (car habitat and pigeon habitat): 
You can use Google Earth or i-Tree to find out with a grey-green analysis (see page 16 for definitions of different habitats, and page 18 and 20  for a 
quick guide on Google Earth and i-Tree)

3
2
1

a. Yes

b. Somewhat 

c. No

2. Do the trees on your block look healthy?

a. 50+ years, mature

b.10-50 years, established

c. 0-10 years, just planted

3. What is the approximate age of the majority of trees on your street? 

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for impacts at the block level           _________

a. Using roof rainwater capture (waterbutts) and rain garden

b. Part of garden irrigated with tap-water

c. Garden fully irrigated with tap water

pointsyour household's vulnerability

1. How do you use and store water?
3
2
1

a. >60%

b. 30-60%

c. <30%

2. % of your house shaded by trees in your yard or on your block in the summer:

3. How much green or pervious area (‘worm habitat’) do you have on your lot?
Include the house area as part of your lot; use Google Earth to help you calculate areas.

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for impacts at the block level            _________

a. >60%

b. 30-60%

c. <30%



RATE YOUR BLOCK
mitigation OF CLIMATE CHANGE

pointswhat your block is doing to cut its carbon footprint

1. % of homes using solar panels on your block:
3
2
1

2. % of cars on your block that are EVs, hybrids, or car-shares: 

a. >60% (meets ‘leaping squirrel test’ check page 13 for the 'leaping squirrel test')	
b. 30%-60% (squirrel habitat but 1-5 gaps)
c. <30% (little connected squirrel habitat)

3. Amount of tree canopy on your block?

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for mitigation at the block level              _________

a. two or more types of renewables>60%

b. one type of renewable 30%-60%

c. only hydropower>60%

pointswhat you are doing to cut your carbon footprint

3. Use of renewable energy (other than hydropower): 
Eg. solar panels, passive solar, air-source heat pump, geothermal (ground-source heatpump), bioenergy

3
2
1

2. % of your store-bought food that is locally-sourced (from B.C. or Washington): 

1. % of trips by bike/bus in one week:

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for mitigation at the household level    _________

a. >60%

b. 30-60%

c. <30%

a. >60%

b. 30-60%

c. <30%

a. >60%

b. 30-60%

c. <30%

a. >60%

b. 30-60%

c. <30%

subtotal
add up the points, and write the number on the right as your subtotal score for adaptation at the block level     _________

subtotal
add up the points, and write the number on the right as your subtotal score for adaptation at the block level      _________



RATE YOUR BLOCK
mitigation OF CLIMATE CHANGE

subtotal
add up the points, and write the number on the right as your subtotal score for mitigation at the block level              _________

RATE YOUR BLOCK
adaptation OF CLIMATE CHANGE

pointshow 'climate-proofed' your block is

1. % of homes growing food (based on what you can see from the street):
3
2
1

a. Within 5 minutes walk

b. 5-15 minutes walk

c. More than 15 minutes walk

2. Distance to nearest park with shading:

a. Mostly large & mature trees

b. Mostly small ornamental trees

c. Very few trees

3. What type of trees on your block?

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for adaptation at the block level     _________

a. >20%

b. 1%-20%

c. None

pointshow 'climate-proofed' your home is

1. What proportion of your food is grown by yourself?
3
2
1

2. What proportion of your property is pervious?
Pervious surface allows water to penetrate through soils

3. What type of trees on your property?

3
2
1

3
2
1

subtotal
add up the points, and write the number on the right as your subtotal score for adaptation at the block level      _________

a. >60%

b. 30-60%

c. <30%

a. >60%

b. 30-60%

c. <30%

a. Mostly large & mature trees

b. Mostly small ornamental trees

c. Very few trees



 

In this exercise participants will learn basic photo-editing techniques 
to change photos of their communities into the kinds of places 
they have been talking about with their neighbours.

AFTER

STEP 4: VISION 
YOUR FUTURE

In this exercise, you will learn basic photo-editing techniques to change photos of your block/
community into the kinds of places you have been talking about with your neighbours. 
Through the visioning exercises, you can explore your block’s futures with climate change 
impacts, and possible green and sustainable solutions. Show the future that you like the 
most and share with your friends and neighbours!

STEP 4: VISIONING YOUR FUTURE

BEFORE
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VISION YOUR FUTURE
what to VISUALIZE

Imagine what your block will look like if - 

OR

and any other possible futures that you want to see (e.g. shared compost piles, rain gardens, 
traffic calming curb gardens, passive solar houses).

Visualization Examples
EXISTING SCENE

LOW CARBON FUTURE
•  More hard surface is coverted to greenspace
•  A community garden/orchard is developed
•  Solar panels are installed
•  More bike lanes are put in place

HIGH CARBON FUTURE
•  Mature trees are gone (because of climate change)
•  Streets are wider for more cars
•  More street parking at your place

28
by Mengqiu Chen, Kristin Defer, Alfred Duval, Siyuan Zhao (2015)

More 
trees

Green walls & 
roof gardens

Green ways



VISION YOUR FUTURE
HOW to VISUALIZE

There are many ways to visualize on your block in the future. Here are two of the most 
common ways:

1.	 With markers (easiest and quickest) – Page 29
2.	 With GIMP (free alternative to Photoshop) – Page 30

1.	VISUALIZE with markers
Print a few copies of the street views on your block, and use markers to draw out the following scenarios. Please see 
detailed instructions on page 17.

You will need: 
•	         30 minutes
•	 Several colourful markers
•	 A couple of photos of your block/yard to map on  

You can print them on regular papers instead of photo papers. Recommended size: 11" by 17" or 18" by 24".

2. VISUALIZE  with

29

by Mengqiu Chen, Kristin Defer, Alfred Duval, Siyuan Zhao (2015)

There are several kinds of visualization tools that are easy to access and use,  e.g. GIMP, Photoshop, Sketchup...
Here are some useful tutorials if you want to try them out:

  • Adobe Photoshop: https://helpx.adobe.com/photoshop/tutorials.html

  • Google Sketchup: http://www.sketchup.com/learn



VISION YOUR FUTURE
HOW to VISUALIZE

You will need:                                                                            
•	        1-1.5 hours

•	 A computer connected with the Internet

•	 Pictures that you want to visualize

What is GIMP?
GIMP (https://www.gimp.org/) is free image editing software that allows you to composite and retouch digital images. 

Here are some quick tutorials to help you visualize with GIMP (the following contents are adapted from GIMP User 
Manual11:

VISION YOUR FUTURE
VISUALIZE with GIMP
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gimp quickies: First and foremost...
Go to https://www.gimp.org/downloads/ to download the installation package and install GIMP by following the 
instruction. 

Here is a quick intro of some key concepts and the interface of GIMP:

•	 Image - basic entity to display and retouch in GIMP. It is like a single sheet of paper where you can draw.

•	 Layer - like a sheaf of transparent papers stacked one on top of the other, so you can draw on each paper (i.e. image) but 
still see the content of the other sheets through the transparent areas.

•	 Undoing - this is very important to know especially when you do something wrong, try the keyboard shortcut: Ctrl+Z.

•	 Saving your work - don’t forget to save your files: go to File > Save as... an .xcf (will save layers) or File > Export 
as... a .jpg (flattens layers).

Basic Arrangement of GIMP Windows (multiple-window mode)

1.	 The Main Toolbox: Contains a set of icon buttons used 
to select tools. You can use Edit>Preferences>Toolbox 
to enable, or disable the extra items.

2.	 Tool options: Shows options for the currently 
selected tool (in this case, the Move tool).

3.	 Image windows: Shows the image that you open in 
GIMP. You can display multiple images at the same 
time.

4.	 Layers, Channels, Paths, Undo History Dock: They 
are shown as tabs. The layers tab shows the layer 
structure of the currently active image, allows it to be 
manipulated in different ways.

5.	 Brushes/Patterns/Gradients: Shows the dialogs 
(tabs) for manging brushes, patterns and gradients.



Work with images: combining elements from more than one image

Work with image: separating an object from its background

Sometimes you need to seperate the subject of an image from its background, and use it on an existing background. 
To do this:

1.	 Select the object using the following tools:

Free Select Tool that allows you  to create 
a selsection by drawing the boundary 
free-hand with pointer.

Intelligent Scissors Select Tool that 
uses edge-recognition algorithms to 
better fit the border around the object.

Foreground Select Tool that let you 
mark areas as “Foreground” or “Background” 
and refines the selection automatically.

2.	 Once you have selected your subject successfully, use Select > Invert. Now, instead of the subject, the background 
is selected. 

3.	 Use Layer > Transparence > Add Alpha Channel to add an alpha channel. Next, use Edit Clear or hit the Del key on 
the keyboard to remove the background. Please note that only a small subset of file formats support transparent 
areas. Your best bet is to save your image as PNG.

Use Clone tool, adjust opacity, brush type and 
size, and then while holding the Ctrl key, sample 
part of an image, then clone it to a different 
part of the image.

Open a new image and duplicate the layer 
(right-click > duplicate). Drag the layer into the 
first image. 

Under Image > Canvas Size, double the canvas 
size, and then move the new layer to the side. 
Clone stamp elements of one layer over the 
other.

The Clone Tool in the Main Toolbox

Detail Setting of the Clone Tool

by laura.ouimette
https://www.flickr.com/photos/8244126@N06/512532859

Want to learn more tools and functions of GIMP, please check GIMP 
User Manual at https://docs.gimp.org/en/index.html
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In this exercise, participants will write down 3 things that they can do to 
help make the vision produced in Exercise 5 become a reality.

19

STEP 5: ACT ON THE GROUND

Now we know the urgency of combating climate change, and the importance of urban trees to our lives. It 
is time to TAKE ACTIONS! This section provides you tips and external resources on what you can do to help. 

1. MAKE A PLEDGE 

2. PLAN AHEAD

3. PROTECT YOUR TREES

4. BEAUTIFY YOUR YARD/BLOCK

by laura.ouimette
https://www.flickr.com/photos/8244126@N06/512532859



ACT ON THE GROUND
MAKE A PLEDGE

What goals are you planning to achieve in the new year?

Are they about preparing for climate change or protecting trees in 
your yard or on your block?

Write them down!

I PLEDGE

#1
e.g. plant a tree that I like in my yard and take good care of it

_____________________________________________________________

________________________________________________________________

___________________________________________________________________________________________________

#2
e.g. water street trees on my block during dry seasons

_________________________________________________________________________________________________________

_____________________________________________________________________________________________

#3
e.g.  volunteer at least once at a City tree planting event with my family and/or neighbours

_________________________________________________________________________________________________________

_____________________________________________________________________________________________

DO YOU KNOW
Vancouver has a Climate Change Action Pledge: 
http://vancouver.ca/green-vancouver/climate-
change-action-pledge.aspx

33

You can start with 
SMALL steps



ACT ON THE GROUND
MAKE A PLEDGE

ACT ON THE GROUND
MAKE A plan

What will you do by when?
Make a calendar to plan small steps that can help you achieve your climate action goal(s), and stick it in a place where 

you see everyday!

PLEDGE 1
________________

________________

________________

PLEDGE 2
________________

________________

________________

PLEDGE 3
________________

________________

________________
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HOW I CAN HELP

BE CAREFUL WHEN USING A 
LAWNMOWER OR WEED TRIMMER12

It can do detrimental damages to the base of the tree. 
Severe damage (like the picture) can kill a mature tree. 

WATER STREET TREES OVER THEIR ROOTS 
IN FRONT OF YOUR YARD12

Two watering cans or 5-10 minutes from a slow-running hose. 
Twice per week will do.  

z
PARTICIPATE IN ARBOR WEEK 
TREE-PLANTING ACTIVITIES12

The City and various organizations e.g. TreeKeepers 
organize at least once tree-planting events per year.

TELL THE CITY IF YOU HAVE ANY 
QUESTIONS OR CONCERNS12

You can request  maintenance of trees in parks and on streets online 
http://vancouver.ca/home-property-development/trees.aspx

ACT ON THE GROUND
PROTECT YOUR TREES
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by City of Vancouver
http://vancouver.ca/files/cov/vancouver-tree-week-caring-for-your-tree.pdf

by Gratisography
https://static.pexels.com/photos/2259/man-hand-garden-growth.jpg

by StuJP
http://www.geograph.org.uk/photo/4589591



by Ted

by Mohamed Rezk

by Famartin

1.  PICK A TREE YOU LIKE 
          Here are some suggestions on trees that are able to survive the future impacts of cliamte change13 14:

‘Forest Pansy’ Eastern Redbud15

(Cercis Canadensis)
Medium-size (20-30 feet tall) deciduous tree with 
beautiful pink flowers and heart-shape leaves 

•	 Can survive well under very dry environment
•	 Prefer full or partial shade
•	 Grow in well-drained sandy/clay soil

‘Workhorse’ European Hornbeam16

(Carpinus betulus)
Large (can be over 40 feet) deciduous tree with pointy oval 
leaves, and a beautiful canopy

•	 Can survive in harsh conditions with little care
•	 Tolerant to various levels of light exposure and soil pHs
•	 Prefer moist and well-drained soil

by Wendy Cutler

by WikimediaImages

by claude05alleva

‘Tough Survivor’ Honey Locust17

(Gleditsia triacanthos)
Medium- to large-sized deciduous tree that can grow up 
to 70 feets with beautiful bright yellow flowers in the fall. 
It is fast-growing and easy to plant.

•	 Flood and drought tolerant
•	 Prefer to grow with full sun exposure
•	 Grow in various types of soil

Flower and Leaves 
by Andrew Butko

Leaves in the Fall
by Chris Sloan

by Kevmin

ACT ON THE GROUND
BEAUTIFY YOUR YARD
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‘Pollution Fighter’ Garry Oak18 19

(Quercus garryana)
The only native oak species in B. C.. It can grow up to 70 
feets with majestic large canopy. It is great for improving 
air and water quality, and provides habitats for a number 
of rare plants and animals.

•	 Once established, minimal maintenance is needed
•	 Can tolerate very dry conditions
•	 Prefer open space with full or partial sunlight
•	 Grow in well-drained coarse sandy soil

Flowers
by Su-Laine

Leaves
by brewbooks

by iangbl

‘Well-Rounded Adapter’ Green Ash20

 (Fraxinus pennsylvanica)
Medium-sized (can be over 85 feet) deciduous tree. 
Leaves turn golden yellow in the fall. It is fast growing and 
provides nice shade in the summer:

•	 Can survive in harsh conditions with little care, e.g. droughts 
and floods

•	 Prefer full sun exposure
•	 Tolerant to various levels of pollutionsm and soil textures 

& moisture

WANT TO KNOW MORE SPECIES?

Trees in B.C. and identification keys: 
https://www.for.gov.bc.ca/hfd/library/
documents/treebook/trees.htm

Tree Keepers: 
http://treekeepers.ca/plant-a-tree/

Native plants in B.C.: 
http://www.npsbc.ca/

Still having a hard time picking a tree you like? 
Try the Tree Match: http://vancouver.ca/parks-recreation -culture/treelationships.aspxa

by Jim Championby Steven Katovich

Leaves in the Fall
by Famartin
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2.  WHERE TO BUY A TREE 
          You can buy trees or seedlings at local flower stores or tree nurseries (see below)

Tree Nursery by Jonathan Billinger
https://commons.wikimedia.org/wiki/File:Tree_Nursery_

near_Cattal_-_geograph.org.uk_-_279007.jpg

Plant Store from Google Image Gallery

You can also buy trees for only $10 at the City's Tree Sale Event. It is usually three or four times a year.  Check 
the City's website for more information http://vancouver.ca/parks-recreation-culture/vancouver-tree-weekend.
aspx
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3.  WHERE TO PLANT A TREE 
          You can buy trees or seedlings at local flower stores or tree nurseries (see below)

KEY
1.	 Coniferous windbreaks to the north and west block winter winds.
2.	 Trees on the east and west sides provide summer shade.
3.	 A tree here will provide shade as the sun sets in midsummer.
4.	 A variety of deciduous trees to the south should grow tall and permit pruning of lower branches so that 

lower winter sun will strike the roof, walls, and windows uninterrupted.
5.	 The year-round effect of foundation and driveway planting seems never to have been measured, but they 

would be expected to be energy savers if they do not shade windows in the winter.

From Forest Stewardship Backyard Trees21
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4.  HOW TO PLANT A TREE 

Need some help plant a tree? Here are some guides from the Vancouver Board of Parks and Recreation22:

1. DIG A SAUCER-SHAPE HOLE 3-4 times wider than the container or rootball. Make sure it is the same depth 
as the root ball.

2. PLACE THE TREE IN THE CENTRE of the hole. The top 
of the rootball must rest at ground level. If your tree is in a 
container, gently tap the sides of container to help loosen 
the edge and slide the trees out carefully. 

* DON'T PLANT TOO DEEP! Roots require air as well as 
water to grow.  The tree root flare (the bottom part of the 
trunk that flares out) should be above the soil. 

* To prevent the roots from growing in a circular pattern, 
cut a few vertical slices along the sides of the rootball. You 
can also gently spread the roots making sure not to break 
them.

* FOR BALLED & BURLAPPED TREES, cut away any twine 
or wires wrapped around the rootball and peel back the 
burlap.

3. BACKFILL THE HOLE WITH NATIVE SOIL FROM TREE 
PIT. If the soil is of marginal quality, ensure that topsoil 
amendment is thoroughly mixed with native soil.

SOME MORE TIPS ON TREE CARE22:
1. MULCH is an invaluable tool to improve the soil and provide more nutrients 
for the trees.

2. BEWARE OF THE WEED EATER. They can do devastating damage to trees.

3. WATER. WATER. EVERYWHERE. For the first few years, water your new tree 
twice a week during the summer. Water slowly for 5-10 minutes (10-20 litres of 
water or 2 watering cans or use a watering bag).

5-10 minutes 

FOR MORE TIPS, please see the full version: http://vancouver.ca/files/cov/vancouver-tree-week-caring-for-your-tree.pdf
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WORK WITH YOUR NEIGHBOURS TO CREATE A GREEN & CALMING 
SPACE ON THE BLOCK

•	 Boost the character of your block by personalizing gradens

•	 Slow down traffic on your block

•	 Provide free compost for your own garden, and sometimes 
even free food (depending on the species that you plant)

•	 Strengthen the bonds with your neighbours and friends

•	 They are just beautiful to look at!

You can create a street garden on the traffic circles or on the street in front of your place by planting plants 
that you like.  Creating this type of green space can benefit you and your block in various ways23:

Steps to create a street garden23:

1. Decide what type of garden you and your neighbours want 
to create: e.g. food gardens, bee hives, ornamental gardens...

2. Pick plants that you like.
Recommended plant list: http://vancouver.ca/home-property-
develop ment/recommended-plant-list.aspx

3. Plan a day with your neighbours to plant!
Watch out for traffic when you are working. Stay visible and stay 
alerted.

For more specific rules and guides, please visit http://vancouver.ca/
home-property-development/gardening-guidelines.aspx

You can also volunteer for the City's Green 
Streets Program to help them take care of 
street gardens near you. You will weed and 
water the gardens, make new friends, receive 
free training on gardening and various fun 
events by the Green Streets23. 

Sign up here: http://vancouver.ca/home-
property-development/green-streets-
volunteer-application-form.aspx

ACT ON THE GROUND
BEAUTIFY YOUR BLOCK
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by Erin MacDonald
http://www.yourleaf.org/blog/erin-macdonald/2014-02-06/sayo-new-volunteer-and-stewardship-coordinator
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PICTURE REFERENCES:
Easter Redbud 
•	 https://commons.wikimedia.org/wiki/File:2013-05-16_09_38_27_Eastern_Redbud_along_Terrace_Boulevard_in_Ewing_

Township,_New_Jersey.jpg

•	 Flowers: https://www.flickr.com/photos/frted/4506145671

•	 Leaves: https://commons.wikimedia.org/wiki/File:A18-2-Cercis_Canadensis_(Eastern_Redbud).JPG

European Hornbeam 
•	 https://www.flickr.com/photos/wlcutler/2557085953 at Vancouver Thurlow 

•	 New leaves: https://pixabay.com/en/carpinus-betulus-european-hornbeam-846553/

•	 Golden leaves: https://pixabay.com/en/foliage-beech-leaves-fall-539413/

Garry Oak 
•	 https://www.flickr.com/photos/iangbl/751184866

•	 Leaves: brewbooks https://www.flickr.com/photos/brewbooks/178394483

•	 Flowers: https://www.flickr.com/photos/syeo/3436583864

Honey Locust 
•	 https://commons.wikimedia.org/wiki/File:Gleditsia_triacanthos_Maryhill_Museum_01.jpg

•	 Flowers: https://commons.wikimedia.org/wiki/File:Gleditsia_triacanthos_in_Donetsk_3.jpg 

•	 Leaves: https://www.flickr.com/photos/sloanpix/2962833007
•	

Green Ash
•	 https://commons.wikimedia.org/wiki/File:Fraxinus_pennsylvanica_tree.jpg

•	 https://commons.wikimedia.org/wiki/File:Ash_tree_in_the_overflow_car_park_at_Buckler's_Hard_-_geograph.org.uk_-

_177027.jpg

•	 Leaves: https://commons.wikimedia.org/wiki/File:2014-10-29_12_51_30_Green_Ash_foliage_during_autumn_leaf_colora 

tion_and_other_small_tree_foliage_in_Ewing,_New_Jersey.JPG
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